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Document summary

This document describes ADSelfService Plus login agent, its uses, and the method to install it using a
GPO. The document is written for a system administrator with a basic understanding of the Windows
operating system, Active Directory (AD), and enterprise software deployment. However, care has been

taken to keep the installation steps as simple as possible.

The ADSelfService Plus login agent

With the ever-changing technological landscape, attackers are finding new methods to crack user
credentials and gain access to their AD domain accounts. Although good password hygiene and
advanced password policies can help create strong passwords, depending only on a single level of

authentication isn't a secure move.

Moreover, when using web-based self-service software, end users no longer need help desk personnel
for password reset and account unlock operations. However, using web-based self-service means that a
user who has forgotten their password, and therefore has no access to their machine, either needs a

colleague's machine or a dedicated kiosk to carry out the required self-service operations.

ADSelfService Plus addresses the above scenarios through its login agent. The ADSelfService Plus login
agentis an extension of the standard Windows login screen. When installed, it enables MFA for Windows
logins and adds a button labeled "Reset Password/Unlock Account" to the native Windows login screen,

allowing users to reset their passwords and unlock their accounts right from that screen.

The ADSelfService Plus login agent is compatible with the following operating systems:

© Windows Vista © Windows Server 2003
o Windows 7 © Windows Server 2003 R2
© Windows 8 © Windows Server 2008
© Windows 8.1 ©  Windows Server 2008 R2
©  Windows 10 ©  Windows Server 2012
© Windows 11 ©  Windows Server 2012 R2

© Windows Server 2016
© Windows Server 2019
© Windows Server 2022
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ADSelfService Plus login agent installation via GPO

Important: Before starting with the steps below, place the ReinstallAgent.vbs and
ADSelfServicePlusClientSoftware.msifiles in a network shared folder on your server.

The ADSelfServicePlusClientSoftware.msifile is available in the bin directory of the
ADSelfService Plus installation folder. The default location is C:\Program
Files\ManageEngine\ADSelfService Plus\bin.

The ReinstallAgent.vbsfile is available for download from the ADSelfService Plus admin portal.
Log in to the product admin portal and go to Configuration > Administrative Tools > GINA
/Mac/Linux (Ctrl+Alt+Del). Under the Installation Help Guide section, click on GINA Login
Using GPO (Group Policy Object). Download the file using the link available in Step 5.

Note: If a new Installation Key is generated, the admin will need to download the
ReinstallAgent.vbs file from the product admin portal and use it to replace the existing file it in
the Network Share.

Best practice: Create a group and add all the computers on which you want to install the
ADSelfService Plus login agent. Create a GPO and apply it to this group.

Prerequisites

1 The Endpoint MFA add-on for ADSelfService Plus is required to enable MFA for Windows logins.
Visit the store to purchase the add-on.

2 The ADSelfService Plus Professional Edition is required to enable self-service password reset and
account unlock on Windows login screens.

3 Avalid SSL certificate must be installed in ADSelfService Plus and the Access URL must be configured

to use the HTTPS protocol. You can find the steps in this guide.

For successful installation, do the following steps in order.

Step 1: Create a GPO and name it

For Windows Server 2008 and above

1. Open the Group Policy Management console.

2. Onthe left pane, right-click the Group Policy Objects container and select New.
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Group Policy Management [_|

i Fle Adion View Window Help =l

-

Group Policy Objects in adssp.local.com

Contents | Delegation |

adssp local, com_ADawuditPlusPolicy
Default Domain Palicy Name = [ .6PO Status [ Fier | Modified [ Dwner

& 51 1115ample = 2kBGMM Ensbled None 71572011 7:24:38 PM Domain Admins
i "DSS:R it s Enabled None 4177/2012 BAZA0 M Domain Admins
&l 2] ananthkz_bal =] AccounLockoutPalicy Enabled None 9/19/2012 43346 PM Domain Admins
P e in ADP Enabled None 4019/2012 5:38:22 PM Dormain Admins
a
g o ADM-GPO Enabled None 4/16/2012 51232 P Domain Admins
9 B Dormsin Cortralers =] adssplocalom_ADAudiPlusPolicy Enabled Mane 7/26/2012 105045 AM Domain Admins
= B Dont Delete | adsspIocalcom ADAudPlusPolicy Ensbled None 5/18/2012 305:02 PM Domain Admins
£ (B External Data souress adssplocal.com_ADAudiFlusFolicy Enabled None 8/1/20121240:00 i Domain Admins
® ananthke-geo Enabled Mane 40262012 6:29:22 PM aketest] (skete
® & M = ANother Ensbled None 742672012 1:02:28 PM Domain Adrins
B E] KarthikTest | ArotherGPO Compuler configuration seflings disabl..  None 1/30/2012 34754 P Domain Admins
#1 2] kumar<>testion§§%SSmaheshl Enabled Mane 1/25/2012 104502 M Domain Admins
B 2] maheshi1 {mahesh kumar) Lswin Ensbled None 8/6/2012 8:43:00 PM Domain Admins
&l (5] rimal_test Clien_850 Enabled None 10/11/2011 85164 Pl Domain Admins
B & Fartha's OUs client_sw_push Enabled Mane 12/20/2011 4:08:40 P Domain Admins
il po =] Deefault Domain Cortrolers Policy Ensbled None 9/13/2012 5:20:45 &M Domain Admins
] (5] ramaraian =/ Diefault Domain Felicy Enabled None 9/26/2012 B:20:26 P Domain Admins
Bl "‘tes: examle Al settings disabled None 142472012 1:48:12 PM Domain Admins
B ?T}fiou Ensbled None 242342012 35640 PH Domain Adrins
#
g - Ensbled None 1043172012 1:22:08 PM Domain Admins
- = HE Computer configuration settings disabl . None 20142012 7:32:56 PM Damain Admins
] special Manage Backups
o B s TING Enabled Mane 9/22/2011 42702 PM Domain Admins
5 aubatre Open Migration Table Editor Enabled Nane 4542012122106 PM Adrinistator (4]
® View » Enabled None 4542012122110 M Administrator [4]
® Hew Window From Here o Policy Object Ensbled Mane 114472011 41318 PM Domain Admins
m p Policy Object Allsetlings disabled None 8/1/2012 1:54:36 PM Domain Adrins
® B word policy Enabled None 12/30/2011 1:45:40 P Domain Admins
JHlE Help word policy - For sentl O Enabled None 12/30/2011 1:5450 P Domain Admins
wore Ensbled None /2272011 4:34:48 P Domain Admins
= Fasspol policy Enabled None 12/25/2011 11:53:38 &bt Domain Admins
&1 (5] Starter GPCs password policy Enabled None 6/6/2012 B:16:00 PM Domain Admins

@ . | 3

3. Give a descriptive name to the GPO and click OK.

& Fle  Acion View ‘Window Help ‘
€9 |2m|0]ddm
B (3 Domains Group Policy Objects in adssp.local.com
B 4 adssplocal.com Corterts | i
5] adssp local.com_ADAudEPusPolicy Helpeinn
.| Defaulk Damain Palicy Nane = [ 6PO Stae [ M Fier [ Modited [ Quner
3 J‘\;‘;’"D‘e =] 2K8GMM Enabled Nene Demzin Adrins
= = Enabled Mere Damnzin Adrins |
= becounLackouPolicy Enabled None 9419/2012 4:3045 PM Do Adrins |
] bap Enabled None 4419/2012 5:3 22 PM Dommain Adins |
-] ADM-GPO Enabled None 4162012 51232 PM Demin Ading
-/ adsspIocal.eom_ADAuGiFusPolicy Enabled None 4262012 0045 AM Demin Ading
= adssp local com_ADAuAIPlusPolicy Enabled Nene 6/18/2012 20502 PM Demain Adins
- adssp local com_ADAUGIPusPolicy Enabled None 8/1/2012 124000 PM Demin Adting
2 None 4262012 6:2922 PM akotest] (akcte
5 o 2r25/om2 102 28PM Dermsinacing |
KarthikcTest = ArotheiGP0 e ] |ere 143072012 24754 PM Demein Ading
o e i
| ] bsnin one omain Adrins
. :”T:‘T[E;J =/ Clent_s50 Soutce Starer GFO. None 1041172011 85154 P DemainAdmins
artha's Ol = clienl_sw_push = | More 12/20/2011 40840 PM Demain Adkmins
[ =/ Default Domain Contrallrs Policy [frore] i 9/13/2012 5:20:45 AM Domain Admins
fameraian -/ Default Domain Poli N 92642012 6:20-26PM Dormain Ad
thiest ] e;;u\e HRka B NZ:Z 1/24/2012 1:4812 PM DZ:::: Aﬁi
2/ BINA None 20232012 25640 PM Demein Adimins
= gk Enabled None 10/31/20121:2208PM Domin Admins
=] GPOGINA Computer configurafion sefings discbl...  None 241/2012 73256 P Demain Adinins
</ GPOTESTING Enabled None 94222011 4:27.02PM Demain Adimins
2 Linkt Enabled Nane 4/5/2012 122106 PM Administator (8]
o Linkz Enabled Nane 4/5/2M2 122110 Administator (8]
=/ New Gioup Poliy Object Enabled None 1247201 £1918PM Demein Admins
New Group Policp Obiect Al setings dissbled Nane 8/1/2012 15436 PM Domain Admins —
=] New passnard policy Ensbled Mane 12/30/2011 1:46.40PM Demin Admins
] Nen passward policy -For senti 0L Ensbled Mane 12/30/2011 1:5450PM Domin Adins
 Group Policy Objects NOPDC Enbled None 94222011 4344 PM Dornain Admins
WML Fiters -] Passport policy Enabled Mane 12/25/2011 11:59384M Domin Admins
3l scarter GPOs = password polcy Enbled Mane 6/6/2012 615,00 P DemainAdmins
< i ] v

For Windows Server 2003 and Windows Server 2003 R2

1. Open the Active Directory Users and Computers console.
2. Right-click the parent container of all the computer objects (which are added to a group—refer

to the best practice above) and select Properties.
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4 Active Directory Users and Computers [_[O[x]
< Ble  Adion View Window Help [T

ev |BE s BXEFRR PE IR TS
-1 ADmPS.0 B computers
7 (& Arun -
) Type Description
e Admp-£-com-11 Computer
o @ aistest B sonp-Exr Computer
5.1 Buitin & admps-camp-1 Computer
B contar 093434 Computer
4.(@) contact, 5 Delegate Control. ., 021 Computer
£ (&1 Customert,  Find... 0-1 Computer
R I e — (1= Computer
&) pomain o W 03 Computer
(0] Foreigrisee P Tasks 04 Computer
{1 HOD-GPO | ey b l05 Computer
{1 home_Fold | ey, windaiy From Here Computer Satest
&l Wani —— User
[ LostancFo  Refresh
7 (& Microsoft E Export List
(2 Mieresoft
711 NTDS Guot
4] Neest
& NTest-Di

-4 NTest-Enabled

7 {2 NTest-Move

+] (&) NTestContact

71 {21 NTestCreateUser

+] (2] praveen1465

711 Program Data

(& rhrest

~{&] subathra

#]-( System

{1 test_oufou

+ () testou

-] Users

0 (&) vaideeTest OU

+.{&] Validation_6_Santron |
KT I E

(©pens the propetties dielog box For the current selection.

3. Inthe Properties dialog box that appears, select the Group Policy tab. Under this tab,

click New to create a GPO.

ectary Users and Computers - (O] x|

&5 Fle Acion View Window Help ‘;lilﬂ

B p— Mame Type Description
Balatest
% EZiEi:s GINA - Computers Properties [7] <]
2 computers General | Managed By | Object | Securty | CoM+
(5] contact_5240_test
{2 Customerlssue Taimprove Group Palicy management, upgrads t the Group Palicy
23] Do Mot Delete Management Console [GPMC),
{£) Domain Controllers
(1 ForsignSecuriyPrincipals Currert Group Policy Object Links for GINA - Computers
(&) HoD-GPO
(5] home_Folder_TEst
@) Mani Group Policy Dbject Links Mo Override | Disabled

-] LostAndFound
(&) Microsoft Exchange Secur
{2 Microsoft Exchange Syste
(L NTDS Quotas
(& Neest
&) NTest-DisabledUsers
{1 NTest-Enabled Group Policy Dbjects higher in the list have the highest priority
2] NTest-Move This list obtained from: admp-dc1. admp.com
{&] NTestContact
&) NTestCreatelser Hew Add |
{4 praveenldes
-[_]) Program Data
{43 rtest
(& subathra I~ Block Policy inheritarice

&) test_oujou ,—I
B tocto Close e |

{4] vaideeTest OU
(€] walidation_6_Santron
{43 GINA - Computers -

B |

Options.. | Delete.. | Properies | Down |
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Step 2: Configure script settings to run ReinstallAgent.vbs at start-up

1. Right-click the GPO you just created and click Edit to open the Group Policy Object Editor.

4 Active Directory Users and Computers [_ o] |

&) Fle  Acton View Window  Help ‘;Iilﬁl
o |Om B XFRR 2E glaVEE

| cina - computers

5y

o

& ayyanar i Type Desaription

Balatest

= |
3 ruin GINA - Computers Properties [z1x]

% Computers Geners!| Managed By | Obiect| Secuiy | COM+ Group Poicy |
contack_S240_test

ustomerssue aimprove Group Policy management, upgiade to the Group Policy
(&) Customer: T Growp Pol e ba the Group ol
(] Do Not Delete Mar\agemar\t Console [GPMEC]

(] bomain Controllers
= L —_ Current Group Policy Olbject Links for GINA - Computers

(&) HoD-GPO!
~(&) home_Folder_TEst

(&1 Mani Grnug Poliy Dbject Links | No Overide | Disabled

121 LostAndFound
[&] Microsoft Exchange Secur
{2 Microsoft Exchange Syste:
{3 NTDS Quotas
(&) Neest

«+{42] NTest-DissbledUsers

«+{d3] NTest-Enabled Giraup Pelicy Objects mg highest prioity.
() NTest-Move This lit obtained fom: 2 Delete,.
{&] NTestConkact Rer\ame
(2] NTestCreatelser New A J Up
(] pravesn1dss | B PR L |
{1 Program Data ~ =

(] rheest
(] subathra I™ Block Policy inheritance:
1] System
i o || Gael || el |
{3 users

(&) YaidesTest OU
() Yelidation_6_Santran

Ho Ovemde
D\sab\ed

Hew
Add

Options Dot |

(] GIMA - Computers =
R o

2. Depending on your operating system, do the following:
© For Windows Server 2003 and Windows Server 2003 R2: In the Group Policy Object Editor, on the
left pane, double-click Computer Configuration > Windows Settings > Scripts

(Startup/Shutdown) > Startup.

© For Windows Server 2008 and above: Double-click Computer Configuration > Policies >
Windows Settings > Scripts (Startup/Shutdown) > Startup.

(o poliypectpitor —————————————————————— —————— mmmE|
Ele Action Yew Help

- | aEB|2

E GINA-GPO [admp-dc 1, admp.com] Policy

£ @ Computer Configuration
@] Software Settings

Bl Scripts (Startup/Shutdown)

Hame |

Windows Set Startu
P lstaron

i Display B i [E)shutdovn
: isplay Properties
i -0 Administr ative Templates plary Eroperiies
1 2 User Configuration X

(-] Software Settings Description:

(-] Windows Settings Col_wta\ns computer startup

(-] Administrative Templates scripts,

% Extended A Standard /
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Flle Action Yew Help
alad B2
_=:j‘ GINA-GPO [admp-de . admp.com] Palicy
{8 Computer Configuration
(L] Software Settings
(L windows Settings Startup
Scripts (StarkupdShutdon
e s
ISPl roperties
(L1 Administrative Templates Py
o3 User Configuration ; .
(2] Software Settings Cescription:
(22 Windows Settings Contains computer startup
(L1 Administrative Templates scripts.
Extended A Standard /

|0pens the properties dislog box For the current selection.

a. Inthe Startup Properties dialog box, click Show Files.

Elle  Action  Wew Help

== E3

&= DM R 2@

Z§ GINA-GPO [admp-del.admp.com] Policy
B @ Computer Configuration

[#1-[L] Software Settings

=121 Windows Settings

| Seripts (StartupiShutdown)

[#- 5 Security Settings
[ Administrative Templates
=12 User Configuration

(-2 Software Settings

([ Windows Settings
(23 Administrative Templates

Shutdown)

Mamme |

Startu
P tartup
' ’ Ellshutdawn
Cisplary Properties
Startup Properties

DCescription: Seripts |
Contains compute
scripts.

I
Up
Do
Add

Edit,
Hermowe

Ta view the script files stored in this Group Policy Dbject, press
the: button below

0K Cancel Ll

Extended 4 Standard 7
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b. Paste the ReinstallAgent.vbs script file in the startup folder window that opens, then
close the window.

‘i Group Policy Dbject Editor

Filz  Action Yo Help f# ' .admp.comSys¥oliadmp.com‘Policies’ {E381F36A-BD5 7-4036-A1BB-BDOOEC532716} \Machine' Scripts\ Star |
& = | | B 2 File Edt View Favortes Tools  Help ‘ E
EJ GINA-GPO [admp-dc1.admp.com] Policy Geach - €3 % ‘ ) Search (o Folders \ a6 \ [
= { Computer Configuration — -
51 (2] Scftware Settings address [ 1{admp. com|Sysvol|admp. comiPolicies|{£361F 36.4-BD57-4036-A1BE-BD0DECE327 16} Machine\Scripts|Startup BN =
=[] Windows Settings $ o
Scripts (Startup/Shutdown)
L BB otk Gothinme )
Scripts |

Startup Scripts for GINAGPO

Name | Parameters

T view the seript files stared in tis Group Poli
the button below

- — Clicking 'Show Files' opens a folder window.
M| i Paste 'ReinstallAgent vbs file in that folder.

)

o0 | 1\ Extended 4 Standard 7

c. Inthe Script Parameters field, enter /MSIPATH:"%msifilepath%" (here, replace %msifilepath% with the

path to the Network Share folder location where ADSelfServicePlusClientSoftware.msiis stored.)

Example: /MSIPATH:"\\XYZ\Jone\ADSelfServicePlusClientSoftware.msi"”
/SERVERNAME:”XYZ /PORTNO:"8888" /[FRAMETEXT:"If you've forgotten your password.”
/BUTTONTEXT:”Reset Password”/PROD_TITLE:"ADSelfService Plus” /PROTOCOL:”https”
/WRAPPINGPROVIDER:“{6f45dc1e5384-457a-bc13-2cd81b0d28ed}” /IMAGEPATH:
"\\XYZ\Jone\key.png”/WINDOWSLOGONTFA: “true” /BYPASS:"false”

MSIPATH is a mandatory parameter. If the admin would like to customize the installation, the parameters

in the following table can also be used during this step.
Note: The starred(*) parameters are applicable only in cases where the server is offline or unreachable.

Otherwise, the enforced status will be decided in real time based on the policy configuration settings

in the product.
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DESCRIPTION

SERVERNAME ServerName The server on which Specifies the ADSelfService Plus DNS
ADSelfService Plus hostname to be contacted, after GINA
is running (based on login agent startup during machine
the Access URL login or self-service password rest and
configured) account unlock

PORTNO PortNumber The port number Defines the port number used by the
of the ADSelfService | ADSelfService Plus server.

Plus server (based
on the Access URL
configured).

SERVER- Server- None The context path of the ADSelfService

CONTEXTPATH ContextPath Plus server.

To know more about the context path,
click here.

INSTALLATION_ InstallationKey None The installation key that links the

KEY ADSelfService Plus server and client

securely.

BUTTONTEXT ButtonText "Reset Password / Specifies the button text visible on the
Unlock Account"” Windows login to launch the Reset

Password/Account Unlock wizar.
BYPASS Bypass FALSE Determines whether MFA should be

bypassed when the ADSelfService Plus

server is unreachable during

machine logins.

FRAMETEXT FrameText "Can'tlogon? Please | Specifies the text to be displayed as the
click Reset Password | description. (Applicable only for
/ Unlock Account Windows XP.)
button to reset your
password or unlock
your account."

GINAHOSTE- GinaHostExclude okta, onelogin Specifies the hosts to which a connection

XCLUDE

can be established from the login agent.
By default, all hosts except the
ADSelfService Plus server will be
restricted. But this parameter must be
used if SAML authentication is enabled
for MFA and third-party IdPs are
configured.

www.adselfserviceplus.com


https://www.manageengine.com/products/self-service-password/
https://download.manageengine.com/products/self-service-password/adselfservice-plus-ssl-installation-guide.pdf

ManageEngin@

ADSelfService Plus

MFAENROLLMENT | MFAEnrollment "Multi-Factor Defines the text that will be used as the
WINDOWTITLE WindowTitle Authentication - title in the MFA enrollment window.
Enrollment"” Applicable only when enrollment is
enforced for MFA for machine logins.
MFAWINDOWTITLE MFAWindowTitle "Multi-Factor Defines the title of the MFA window
Authentication” displayed when MFA gets prompted
by the login agent.

PPE_POPUP PpePopUp TRUE Determines whether password policy
requirements must be displayed in the
Ctrl+Alt+Del change password
screen or not.

PROD _TITLE ProductTitle "ADSelfService Plus" | Specifies the title to be displayed when
the login agent window opens during
self-service actions or MFA.

RESTRICTBADCERT RestrictBadCert TRUE Determines whether to restrict usage
of expired, self-signed, or invalid SSL
certificates during self-service actions
and MFA.

Note: We strongly advise against setting
the login agent to work even when the
SSL certificate is invalid in your
production environment, as it will
severely impact security. Please disable
this only for testing purposes.

SERVERUNREACH  ServerUnreach Server unreachable Defines the error message to be

due to intermittent displayed if the server is unreachable
network connectivity | during password reset, account

or improper SSL unlock, or MFA.

certification, or as

the Domain

Controller configured

in ADSelfService Plus

is down. Please

contact your

administrator.

SHOWADSSPLINK ShowADSSPLink TRUE Determines the ADSelfService Plus link
in the Ctrl-Alt-Del screen.

SHOWADSSPTILE | ShowADSSPTile TRUE Determines whether the Reset

Password/Account Unlock button is
displayed as a credential tile on the
login screen.

www.adselfserviceplus.com
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WINDOWSLO- WindowsLogonTFA  FALSE Determines whether MFA for Machine
GONTFA Login has been enabled.
MACHINEMFA- MFAUsage 5) Determines whether the MFA for
USAGESCENARIO*  scenarioMask Machine Logins feature will be enabled

for specific scenarios based on the
value provided. Learn more.

SCENARIO

WHERE MFA PARAMETER

VALUE

IS REQUIRED

For machine login 1

For locked machines 2

For RDP server 4
For UAC 8
For RDP client 16

Note: If you wish to enable MFA for multiple scenarios, you will have to mention the value of the sum of

those scenarios in the MACHINEMFAUSAGESCENARIO parameter.

For instance, if you want to enable MFA for both logging in to a machine and unlocking a machine, add

their respective values (1+ 2) and pass the result (3) as the parameter.

MATCHING

DEFAULT

:aﬁé\/lETER REGISTRY PARAMETER DESCRIPTION
VALUE VALUE

ISMACHINEMF- isMFAEnforced FALSE If set to true, MFA will be enforced for all

AENFORCED* users accessing the machines
irrespective of their enrollment status,
self-service policy membership, or
ADSelfService Plus connectivity status.

IS_VPN_ENABLED IsVpnEnabled None Specifies whether the cached credentials
update feature is enabled or not.

IS_TP_VPN_ ISTPVPNEnNabled None Specifies whether a third-party VPN

ENABLED (VPN providers other than the native
Windows VPN) is enabled.

VPN_SERVER_ VpnServerName None Specifies the VPN server's name.

NAME
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VPN_PORT_NO

VpnPortNo

None

ManageEngin?’

ADSelfService Plus

Defines the ADSelfService Plus server's
port number used to connect to VPN.

PRE_SHARED_KEY

PreSharedKey

None

Defines the value of the pre-shared key
configured while setting up the Native
Windows VPN for the cached credentials
update feature.

VPN_GROUP_
NAME

VpnGroupName

None

Specifies the VPN group name used when
configuring Updating Cached
Credentials over VPN feature. Required
only when a Cisco AnyConnect

VPN is used

VPN_DOMAIN_
NAME

VpnDomainName

None

Defines the domain name to which the
VPN should be connected during
cached credentials update. Applicable
only when SonicWall NetExtender or a
custom VPN provider is used.

VPN_TYPE

VpnType

None

Defines the VPN connection behavior for
cached credentials update based on the
provider used. This pre-set number key
is used to denote the VPN provider.

VPN NUMBER

PROVIDER VALUE

Custom VPN 0

Fortinet and Cisco IPSec 1

The native Windows VPN 2

Cisco AnyConnect 3

SonicWall NetExtender 4

Checkpoint Remote 5)
Access VPN and
SonicWall Global VPN

Open VPN 6

n

VPN_CLIENT_
LOCATION

VpnClientLocation

None

Specifies the VPN client location.
(Example: C:\Program Files (x86)\
Fortinet\FortiClient\ FortiSSLVPN
client.exe)
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VpnConnectCmd None
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VPN provider-specific command that is
used to connect to the VPN during cache
credentials update.

VPN_
DISCONNECT _
CMD

VpnDisconnectCmd  None

VPN provider-specific command that is
used to disconnect from the VPN during
cache credentials update.

WRAPPINGPRO-
VIDER

WrappingProvider None

GUID of your third-party GINA/CP
extension.

IMAGEPATH GPO script parameter Enter the file path of the BMP file to be
used as the client software icon. The
filename should be reset_icon.bmp.

CUSTOMTITLE GPO script parameter Specifies the network share or path of

ICONPATH the icon file used as client software

favicon. Ensure that the custom title
icon is uploaded at C:\\Windows\\
System32\\ADSSPDesktop.ico. The
filename should be ADSSPDesktop.ico.

Note: For Windows Server 2003 and Windows Server 2003 R2, the parameters for the script should be

enclosed within double quotes to support multiple parameter values.

PARAMETER
NAME

OFFLINEMFA

MATCHING
REGISTRY
VALUE VALUE

OfflineMFA FALSE

DEFAULT
PARAMETER

DESCRIPTION

Specifies whether offline MFA is
enabled or not.

LOCALE_ID

Localeld NONE

Specifies the display language used
for some parts of the login agent.

LANGUAGE

Simplified Chinese

KEY

zh-cn

Japanese

ja

French

fr-fr

German

de-de

Turkish

tr

Spanish

es-mx

Polish

pl

OFFLINE_WEB_
LOGO_NAME

12

OfflineWebLogo-
Name

NONE

Specifies the filename and the format of
the custom logo to be displayed during

offline MFA. The filename must be in the
format customLogo.png. The supported
formats are jpg, joeg, bmp, png, and gif.
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LOGOIMAGEPATH | GPO script NONE Mentions the network share path of
parameter custom logo used during offline MFA
(this will be copied to C:\\Windows\\
System32\\ folder location).

Note: If your organization uses the context path functionality of the Tomcat Server, use the

SERVERCONTEXTPATH parameter in the ADSelfService Plus login agent installation command.

Configure Access URL

*server Name | selfservice.cofh/adssp

“protocol () HTTP (8) HTTPS

“port | 9251

The context path can be found at the end of the ADSelfService Plus Access URL. In this example, it is /adssp.

If this parameter is used in the installation command, it will look like this example:

msiexec /i "\\ADSelfServicePlusClientSoftware.msi"
SERVERNAME=abc.selfservice.com" PORTNO="443"
INSTALLATION_KEY="19d82629b4e540fc873df8775d3630cb"
SERVERCONTEXTPATH="/adssp"

This functionality is available only for Windows clients.

Step 3: Configure Administrative Templates settings

1. Depending on your operating system, do the following:

o For Windows Server 2003 and Windows Server 2003 R2: On the left pane of the Group Policy Object
Editor window, double-click Computer Configuration > Administrative Templates > System.

o For Windows Server 2008 and above: On the left pane of the Group Policy Management Editor window,

double-click Computer Configuration > Administrative Templates > System.

2. Under System, configure the following settings:

a. Scripts:

© Ontheright pane of the Group Policy Object Editor, double-click Run logon scripts synchronously
and select Enabled. Click Apply, then click OK.
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© Double-click Specify maximum wait time for Group Policy scripts and select Enabled.

Click Apply, then click OK.

Group Palicy Object Edi M [=] B3 I

Eile  Action ‘Wew Help
e = Em E R 2

GINA-GPO [admp-decl.admp.com] Policy
= @ Computer Configuration

[#-(] Software Settings

E| (L1 Windows Settings

é (1] Administrative Templates
D Windows Components
B[] System

£

E
£

Scripts {SkartupiShutdown)
Security Settings

Logon
(L] isk Quotas

]--D Net Logon
(L1 Group Palicy

D Remote Assistance
(L] System Restore

]--D Error Reporting

(12 windows File Protection

--[Z1 Remate Procedure Call

-2 Windows Time Service

1--[:] Internet Communication Manac

£

F- (1 Metwark

-1 Printers

=] Q User Configuration
(] Software Settings
[ Windows Settings
EID Administrative Templates

#] (L] Distributed COM

| B

Run logon scripts
synchronously

Display Properties

Requirements:
At least Microsoft Windows
2000

Description:

Directs the system to wait
for the logon scripts to
finish running before it
starts the Windows
Explorer interface program
and creates the desktop.

If you enable this setting,
Windows Explorer doss not
start until the logon scripts
have finished running. This
setting ensures that logon
script processing is
complete before the user
starts working, but it can
delay the appearance of
the desktop,

i S

Setting

| State |

Run lagon &

Run skartup scripts asynchronously

;l @ Run skarbup scripts wisible

Run logon scripts synchronously Properties [ 7] ] pfigured

Setting | Explain I

%{ Run logon scripts spynchronously

Mot configured
Mot configured
Mot configured

rfigured

Supported on:

Brevious Settifa I

HMest Setting

At least Microsoft Windows 2000

o 1

Cancel

| Apply |

Extended /4 Standard /

b. Logon

© Double-click Always wait for the network at computer startup and logon and select Enabled.

14

Click Apply, then click OK.

1 [=]

GIMA

-GPO [acdnp-dct .admp.com] Policy

@ Computer Configuration
-1 Software Settings
=21 Windows Settings

Scripts (StartupShutdown)
Security Settings

- Administrative Templates
D Wwindows Companents
B[ System

[+

(23 User Prafiles

[#-(23 Met Logon
(£ @roup Policy

(23 Remate Assistance

(23 System Restore

(2 Error Reporting

(£ windows File Protection

(L3 Remate Procedure Cal

D wWindows Time Service

-3 Internet Communication Manac
(] Distributed COM

7] Metwork.

{11 Printers

= gﬂ User Configuration

(1] Software Settings
- Windows Settings
(2] Administrative Templates

i =

Always wait for the
network at computer
startup and logon

Display Properties

Requirerments:

At least Microsoft Windows
XP Professional or Windows
Server 2003 famiy

Descripton:

Deterrmines whether
Windows XP waits for the
network during computer
startup and user logen, By
default, Windows XF does
not wait for the network to
be fully inifaized at startp
and logon. Existing users
are logged on using cached
credertigls, which results in
shorter logon times. Group
Policy is applied in the
background once the
network becomes available.

MNote that because this is a

Gl ik

I
Extended

ﬁiRun these programs at user logon

;I b i Da not process the run ance list

Do.nak o the legacy pun lish

Setting | State |
W Don't display the Getting Started welcome screen at logon Mot configured
W Alvays use dassic logon Mot configured

Mot configured
Mot configured
Mot configured

Always wi

Setting | Explain |

E‘i Always wait for the hetwark at computer startup and logon

h Alwars wait For the network at computer skartup and lagon I

or the network at computer startup and |

Mot configured

" Mot Configured

Supported on:

Previous Setting |

Test Setting

At least Microsoft Windows =P Professional or Windo...

=]

Concel |

Apply | [
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c. Group Policy
e Double-click Configure Group Policy slow link detection and select Enabled. Click Apply, then click OK.

S5 [=] 3

File  Ackion Wiew Help

- Bm R @

3’ GINA-GPO [admp-dc 1. admp. cam] Policy

: oup Poli

= @ Computer Canfiguration P
[+ Software Settings

; . . i
(2 Windows Settings Group Policy slow link gt:ﬁg e e et - | __siate |
(=~ Administrative Templates detection ow Cross-Forest User Policy and Roz =
- [ Windows Components 8 Alvways use lacal ADM Files For Group Pc Eruup £ slow link detection Properties [21x]
-
120 System ﬁDisalluw Interactive Users from denera  gajling l Explaml

(C1 User Profiles D‘Sp‘ay p—LO eries ﬁDisk uota policy processing
[ Seripts ; ) £ EFS recavery policy processing % Group Policy slow link detection
Logan Requirerments: Falder Redirection policy processing
a
(2 Disk Quotas At least Microsoft Windows {48 Group Palicy refresh interval For compu
2000 :

=4 Group Palicy refresh interval For domair £ Mot Configured

Remote Assistance Description: Internet Explorer Maintenance policy p

(3 system Restore Defines a slow connection 3 1P Security palicy processing W aemss o=
: @ Er.rnr Repnrtmg ) for purposes o applying @Registry P onnection speed (Rbpsk: [500 =5
(3 wiindows Fil Protection and undating Group Polic @ Remove users ahility ko invoke machine
[ Remote Procedure Call P 9 p Y. g 3 : . ; .
Scripks palicy processing Enter [ to disable slow link detection

(L] Windows Time Service

{2 Irkermet Commurication Mana: | [F the rate at which data is gsecurlty policy processing

@ Software Installation policy processing

4 BEnlna o arsfenedfion te @ Turn off background refresh of Group |
B+ (2] Metwark
[ Print dornain controler prowd\ng ﬁTur’n off Resultant Set of Policy logging
1l a policy update to the

ﬁ User Group Policy loopback processing

= & User Configuration G
=W Wireless policy processing

-1 Software Settings
(-] Windows Settings
(23 Administrative Templates

computers in this group is
slower than the rate
specified by this setfing,
the system considers the

Supported on: At least Microsoft Windaws 2000

connecton to be slow. Previous Setling | Mext Selting |
The system's response to ID—KI Cance] | Apply

a slow policy cormecton
varies among policies, The
program implemerting the

pree) =l

I R ey AR

L | M\ Extended A Standard 7

Step 4: Apply the GPO

1. Onthe left pane of the Group Policy Object Editor, right-click the GPO you are working on

(available in the top-left corner) and select Properties.

"fi Group Policy Object Editor =] B3

File  Action  Wiew Help

Wiew & GINA-GPO [admp-dc1.admp.com] Policy

Export List, ; e i |
Select an itemn to view its e
description @ Computer Configuration
* #user Configuration

(- Windows Setting:
[+ (L Administrative Templates

', Extended 4 Standard /

Opens the properties dialeg box: For the current selection,
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2. Inthe Properties dialog box that appears, click the Security tab.

a. Important note: On this tab, under Permissions for Authenticated Users, uncheck the

Apply Group Policy permission before proceeding.

roup Policy Object Editor

i

T £ |

Fle Acton  Yiew Help

e = @ F R 2 E

GINA-GPO [adrmp-del . admp.com] Palicy

2@ Computer Confcuraton £ GINA-GPO [admp-dcl.admp.com] Policy
(2 Software Settings

- Windowes Settings Select an item to view its I — |

(23 Administrative Templates description. E—':OmﬂutEV_CDnﬁ_gufatloﬂ
=-¢f User Configuration fUser Configuration

(10 software Settings GINA-GPO [admp-dc1.admp.com]

-] Windows Settings

(1 Administrative Templates General| Links

v Properties [ 2] x]

Wl Fiter |

Group o user names:
P Authenticated Users -
€ CREATOR DWHER

€5 Domain Admins [ADMPYD amain Adrins]

€7 Enterpiise Admins [ADMP\E nterpriss Admins)
€71 ENTERPRISE DOMAIN CONTROLLERS

-l |

Permissions for Authenticated Users Allow Deny

Full Cartrol [m}
Read
wite (m}
Create All Child Dbjscts O
Delete Al Child Dbjects —
Apply Group Policy é LI

For special permissions or IIDI advanced settings. Adwanced
click Advanced. —

ok | Concel | apeb |

ooooono

Extended A Standard 7

3. Click Add to open the Select Users, Computers, or Groups dialog box.

16

a. Click Object Types and make sure Groups is checked, then click OK.

A= |

File Action  Wiew Help
e- BEBE

imp-dc1.admp.com] Palicy.
Corfiguration
(1 Software Settings

(21 Windows Settings Se  Gereral| Links WMl Fiter
£ (2 Administrative Templates e
¢ User Canfiguration Group or user names:

& (1] Software Settings
- [ Windows Settings
(3 (2 Administrative Templates

€7 duthenticated Users -
€7 CREATOR DWNER

€5 Domain Admins (ADMPAD omain Adrins)

€7 Enterpise Admins [ADMPAE nierpiise Admins)

€7 ENTERPRISE DOMAIN CONTROLLERS

= PG =l

Selsct this object type

IUSE!S, Groups. or Builtin security principals i Dhbject Types. |

Object Types [21x]

Select the typss of objects you want to find.

DObiect types:

O €5 Builtin secuity principals
a1 =] -

Y, Extende

Cancel
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4. Enter the name of the group that contains all the computers set for login agent installation and

© Highlight the desired group and click OK to return to the Security tab.

click Check Names.

© The group will now be added to the list of Group or user names.

5. With the newly added group highlighted, apply the following permissions:

17

“Fn Group Policy Object Editor

File  Action  Wiew Help

(0]

= @R 2E

::j‘ GINA-GPO [admp-del . admp.com] Policy

EI--@ Computer Canfiguration
(L1 software Settings
(L] Windows Settings
(21 Administrative Templates
=) & User Configuration
(I Software Settings
(L1 Windows Settings
-1 Administrative Templates

A DN Lo " " o Do
INA-GPD [admp-dcl.admp.com] Policy Properties

St General| Links  Secutty | wil Fitar |
de

Group or user names:

€7 CREATOR OWNER
(EE Domain Adrins [ADMPL\Domain Admins)

€72 Enterprise Admins (SOMPLE nterprise Admins)

€T ENTERFRISE DOMAIN CONTROLLERS

Select Users, Computers, or Groups

Select this object ype:

=

IUsels, Camputers. ar Groups

[Eram this location:

Objsct Types

|admp com

Enter the object names to select

Locations.

GINA Computers)

Advanced..

I Check Names ||

0K Cancel |,
]

Cacel | py |

Extended 4 Standard /

"t Group Policy Object Editor

Fle Acion Wew Hep

a. For Read, check Allow.
b. For Apply Group Policy, check Allow.
c. Click Apply, then click OK.

P[] 3

- mER 20

=43 Computer Canfiguration
(7 Software Settings

(] Windows Sattings

£} User Configuration
#-{_] Software Settings
(] Windows Settings

¥ GINA-GPO [admp-dc1, admp. com] Policy

(3 Administrative Templates

(-] Administrative Templates

€5 Domain Admins [A0MPADomain Admins)

€73 Enterpriss Admins [ADMP\Enterprise Adriins)

Fuor special permissions of for advanced setfings,
click Advanced,

Add FRemove
Permissians for GINA Computers Allow Deny
Full Control [m] o =
Read O
Wiite a a
Create Al Child Objects [m] [m]
Delete All Child Dbjscts [m] o -
Apply Group Policy [m] O -

Advanced

=1

Concel | apaby |

Extended A Standard /
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6. Reboot the computers to apply the GPO and wait until the next start-up for the
Reset Password/Unlock Account button to appear on the Windows logon screen.

18

"Tn Group Policy Object Editor

Fle Acion Wiew Help

w = |[mE R @ m

= GINA-GPO [admp-dc. admp.com] Policy
= - Compuker Configuration

F-(_] Softwars Settings

([ Windows Settings

(1 Administrative Templates
=] Q User Configuration

-] Software Settings

(-] Windows Settings

(221 Administrative Templates

£ GINA-GPO [admp-dc1.admp.com] Policy

deseripl General| Links Secuity | wil Fiter |

Group or user names

[PRJRSA . INA-GPO [admp-dc1.admp.com] Policy Properties 2[x

ﬁj Domain Admins [ADMPYDomain Admirs)
m Enterprize Admins [ADMPAEnterprize Adming)

El

Permissions for GINA Computers Bl Deny
Full Cantrol m} 0 =
Fead O
Wilte [m} [m}
Create All Child Objects ] ]
Delete &Il Child Obiscts m] o -
Apply Group Palicy [m} =l

For special permissions or for advanced settings, Advanced I
click Advanced, —

| cancdl |

Lipply

' Extended A Standard /

To apply the GPO directly to computers:

If you prefer to apply the GPO directly to computers instead of the group, please follow

the steps below:

a. Follow steps 1and 2 shown above.

b. Click Object Types. Make sure Computers is checked. Click OK.

c. Use Check Names to find the necessary computers. Highlight the computers you want to

add and click OK to return to the Security tab.

d. Setthe Readand Apply Group Policy permissions to Allow, for every computer that

you just added.

e. Important note: After completing all these steps, remember to uncheck the

Apply Group Policy permission.

f. Reboot all the client machines.
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Login Agent Installation Key

The Installation Key links the ADSelfService Plus Server and Client securely. To generate a new
Installation Key, login to ADSelfService Plus' Admin portal, and go to Configuration > Administrative
Tools > GINA /Mac/Linux (Ctrl+Alt+Del). Under the Installation Help Guide section, click on Manual

Installation Steps. Regenerate the Installation Key using the link in Step 4.

Manual Installation steps X

Windows macO0s Linux

Steps to manually install the GINA Login Agent on Windows

@ Copy the ADSelfServicePlusClientSoftware.msi file from the product
<Installation_Directory>/bin folder.
i ]
@ Paste the msi in the Machine where the Login Agent is to be installed. Run as Administrator.
Sample Preview

@ Click Next. Enter the Hostname or IP Address, Port number and Protocol of the machine on which ADSelfSevice Plus is
running.
ﬂ}; Click thefg] icon below to copy the Installation Key. Paste it into the Installation Key field in the instalition wizard and click

Next.

abcdefghijklmn=****¥x*x¥kgnqrstuvwxyz

!C\ick to Regenerate Installation Kev! If regenerated , the new Installation Key must be used for further installation of the Login
Agent via GPO, SCCM or other software deployment tools.

@ Click Next to start the installation.

Close

Note:
© Please treat the Installation Key like a password. It is sensitive information and must not
be shared. Please regenerate a new Installation Key using the link in the product GUI if the
current Installation Key is compromised.

o If anew Installation Key is regenerated, copy the command with the new Installation Key
from the product admin portal and update the Installation Command field with the new

command for all new installations.

© The generation of a new Installation Key will not affect the existing installations of the
Login Agent on installed machines.
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Testing and diagnostics

To test whether the installation was successful:

1. Inthe Command Prompt of your client machines, type gpresult /v.

2. Ensure that:

© The GPO you configured appears under the subheading Applied Group Policy Objects.

o ReinstallAgent.vbs appears under the subheading Startup scripts.

To diagnose, please check the AdsspScriptlog.txt file in the Windows directory (stored in C:\\Windows

by default) or go to Start > Run and type %windir%\AdsspScriptlog.txt.

If you need any further assistance or have any questions, send us an email at

support@adselfserviceplus.com, or give us a call at +1.408.916.9890.

Visit: www.adselfserviceplus.com

Our Products

AD360 | Log360 | ADManager Plus | ADAudit Plus | RecoveryManager Plus | M365 Manager Plus
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ADSelfService Plus is an identity security solution to ensure secure and seamless access to enterprise resources and
establish a Zero Trust environment. With capabilities such as adaptive multi-factor authentication, single sign-on,
self-service password management, a password policy enhancer, remote work enablement and workforce self-service,

ADSelfService Plus provides your employees with secure, simple access to the resources they need. ADSelfService Plus

helps keep identity-based threats out, fast-tracks application onboarding, improves password security, reduces help

desk tickets and empowers remote workforces.

For more information about ADSelfService Plus, visit

$ Get Quote * Download <) Support
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